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Introduction 
Navigating the complex world of mergers and acquisitions (M&A) and rebranding can yield 
vastly different outcomes. Successful cases, like the Disney-Pixar merger, demonstrate the 
potential for enhanced production capabilities and market reach, leading to successes such as 
"Wall-E," "Up," and "Bolt." Similarly, the Exxon and Mobil merger capitalized on economies of 
scale, significantly reducing costs and boosting efficiency. However, there are cautionary tales 
too, like the Sprint-Nextel merger, which stumbled due to incompatible marketing strategies and 
technological discrepancies, or the Sears and Kmart merger that faltered because it failed to 
adapt to evolving consumer behaviors. 
 
Rebranding carries its own set of challenges and opportunities. Instagram's shift from a Polaroid 
camera logo to a gradient design in 2021 marked its strategic pivot towards video and 
messaging, appealing to a broader, tech-savvy demographic. Dunkin’ Donuts simplified to 
"Dunkin'," modernizing its brand to emphasize a wider range of offerings and appealing to 
health-conscious consumers. On the other hand, Gap’s rebranding effort, which included a logo 
change, ended up costing $100 million and was met with a decline in sales, illustrating that poor 
execution can lead to significant losses. 
 
The underlying factor in the success or failure of M&A and rebranding efforts hinges on 
meticulous attention to detail—ensuring that customers remain confident and enthusiastic 
about changes is crucial. However, the complexity of these corporate maneuvers means there 
are myriad potential pitfalls, from billing system errors to broader operational issues, which can 
undermine customer trust.    
 
In such a high-stakes environment, the expertise of a brand consultant becomes invaluable. 
These professionals are equipped to identify and manage the numerous tasks involved in M&A 
and rebranding—many of which may be unexpected or unplanned. For companies undergoing 
these transformations, the right guidance is not just beneficial; it's essential. 
 
A significant challenge for brand consultants working on mergers, acquisitions, and rebranding 
is the need to adapt their strategies to the unique characteristics of each organization. No two 
companies are the same, and each one is at a different stage in their development and 
transformation processes. A consultant must first establish a baseline understanding of where 
their client currently stands—assessing everything from corporate culture and operational 
systems to market positioning and customer perceptions. With this foundational knowledge, 
they can then tailor their approach, aligning and integrating diverse elements to forge a unified 
brand strategy. This nuanced adaptation is essential not only for resonating with existing 
customer bases but also for attracting new ones, thereby ensuring a smooth and timely 
transition and long-term success of the organization.  
 

1. Understanding the current state of the company’s acquisition/merger/rebrand.  We 
needed to ask targeted questions within the most relevant categories to have the 
highest knowledge of their business and venture. 
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2. Once we determine the most relevant categories and the questions to ask within those 
categories, how do we quantify their position with optimized accuracy?  Once we have 
gathered all the information, our next step is to measure their results.   

3. Interpreting the results to customers.  The assessment needs to provide meaningful 
insight on how long the integration will take, how much it will cost, what is the definition 
of “done”, what items to tackle first, and how to achieve goals while being distracted by 
the integration effort. 

 
Methods 
We concluded the model needed to be broken into three categories: Complexity Index, Strategic 
Readiness, and Resource Level. Through many brainstorming sessions, we determined the best 
way to gather information in these categories would be through a detailed questionnaire. Once 
the questionnaire was completed, we would score the answers. Our final step was to interpret 
for the customers the results of their assessment in a logical and easy to understand way. 
 
Business Challenges 
Challenges 
The major challenge we were up against was how to structure the questions within these 
categories to give the customer the information most valuable to their business. The way to 
achieve this was to accurately quantify the results of their answers. 

• Quantifying Complexity: The merging of two companies introduces many organizational 
challenges, including overlapping roles, divergent cultures, and competing processes. 
This complexity can hinder strategic readiness and impede the smooth execution of 
brand transitions. 

• Quantifying Strategic Readiness: Ensuring that both entities are strategically aligned and 
ready for the merger is paramount. Lack of strategic readiness can lead to resistance, 
confusion, and ineffective resource allocation, further complicating the integration 
process. 

• Quantifying Resource Allocation: Efficiently allocating resources across various aspects 
of the merger, including branding activities, communication strategies, and IT 
integration, is critical. Inadequate resource levels or misallocation can result in delays, 
increased costs, and diminished outcomes. 

 
Activities Done to Address the Business Challenges 
Defining Goals 
Once we stated our main challenges to undertake this project, we had to determine the 
structure of our model. We had to define to the customers and ourselves what Complexity, SR, 
and RL represent, and its importance in the model.  

• The main use of Complexity is to illustrate the businesses standing with their M&A or 
rebranding process. The more complex the merger, the higher the complexity score it 
will hold, and the longer it will take to complete the merger. Therefore, we created three 
levels for complexity, low, medium, and high complexity scores that will help us to 
determine where on a quadrant chart the company falls under.  
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o A low score will range from 0%-50% and will have a base level estimated time for 
completion to be between three and six months. 

o Medium score will range from 50%-75% and will have a base level estimated time 
for completion to be between six and nine months. 

o High Score will range from 75%-100% and will have a base level estimated time 
for completion to be between nine and eighteen months. 

 
Then the scores from SR and RL will either add more time to the merger process, therefore 
increasing the risk of potential customer churn, or keep it as is. 

• Strategic Readiness evaluates how well planned out the business is with their merger 
process with their brand change.  

• Resource Level brings an estimation of how easily the workstream teams can 
accommodate the brands' changes in their expertise. If there are competing priorities or 
staff gaps this could cause delays and increase the number of months until the 
completion timeline.  

o This also can bring the business to look into the areas where they hold low RL, 
and possibly consider outsourcing the resources if they do not have the means in 
house. Or on the other hand if in one department they hold high amounts of 
resources, they may be able to distribute that to another department that is 
lacking.  

 
Once quantified, those results can be integrated into our model, and we can interpret each 
industry company's results, and provide them with feedback on their merger process.  
 
Model Ranking System 
Once the goals have been established, we were able to move forward in creating the survey, 
through Microsoft forms. Once we had defined what Complexity, SR, and RL means for our 
model we had to create a ranking system to receive quantifiable data from our clients' 
customers. 
 
We split the survey into three parts, the first part would focus on the business’ complexity, and 
we gave it a numerical rating of one to three, going from low to high complexity. 

 
Figure 1 Here is an example of a complexity question and how we formatted the ranking. 
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Then the second group was Strategic Readiness where it focuses on how ready each aspect of a 
business is to handle during an M&A process. They also share the same ranking flow from one 
to three, however, their ranking descriptions go from: 

 
Figure 2 Here is an example of a SR question and its ranking. 

 
Then the last group was Resource Level, where its focus was on whether or not the business has 
the inside resources that are necessary for the M&A process. This section’s ranking goes from 
zero to five: 

 
Figure 3 Here is an example of an RL question and how we formatted its ranking. 

 
The less confident they are in resourcing certain departments the higher the chance they will 
need to outsource their resources. The same goes for the departments that have excess 
resources in will be best to delegate them to other departments in need.  
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Creating the Excel Model 
1. Once we finalized our survey questions and their quantifications, we began working on 

creating the excel model. The first part of the model was to export the survey into an 
excel sheet and create a table with a column designated to the function, question, the 
customers score, possible high score, and what departments are associated with each 
question.  

2. “The first step in creating the excel sheet for the model is to export the inputs made by 
the survey into an excel form. Copy the rows and in a new sheet in the same excel 
workbook, click on the top where it says paste special and click on transpose. This will 
turn the Questions and answers from horizontal rows to vertical rows. 

3. Then in a new workbook create the format whether with the tables function in excel or 
just type out the title of each category. Below is an example of how we categorized 
Complexity, Strategic Readiness and Resource level 

 
Figure 4   Here is an example of how the column headers were titled for the complexity questions and scores. 

 

 
Figure 5 Here is an example of how the formatting of the column titles looked for SR and RL, as you can see, we included 
an additional column for departments. Because, throughout our model creation we realized that some questions would 

be associated with multiple departments. 

 
4. Then manually copy the questions and scores from the exported survey into their 

designated columns. Once all the questions and scores have been inputted, that is when 
we turn our focus to the department column. Where we had to go through each 
question with our client and decide which departments go along with which questions. 
Some questions will belong to multiple departments, therefore we had to adjust our 
tables by inserting new rows and duplicating the questions that belong to multiple 
departments. 

 

Figure 6   Here is a basic example of how we formatted the calculation tab. 
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5. On the bottom tab in Excel, we open a new worksheet, and name it the calculations 
section for said business. This is when we begin to use the linking information between 
in the worksheets in this excel form. We used this method for creating the calculation 
tab, we would copy the questions, score, and high scores and link them to source in the 
calculation tab.  

 

Figure 7 Here is an example of how we linked the sources between the different worksheets in excel. We first copy what 
information we wanted, then in whichever of the tabs we wished to paste the information we would right click, the select paste 

special, and click on link to source. 

 

 

Figure 8   Here is the after for the complexity calculation, once the information from the previous tab has been linked to this 
work sheet. All that was left to do is include the manual formulas to calculate their average scores using the SUM () function. 
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Figure 9   Here is the calculation example for one for the departments in Strategic readiness, however, resource level will also 
follow the same format. We linked the questions, score, and high score for the Resource and Ease of Outsourcing department to 

get those scores. 

 

 

Figure 10 After taking the sum of the scores and high scores from each department, and then dividing the score by the high 
score to get the average SR and RL for each department. Once that has been done for the department, we then took the average 
of whose strategic readiness and resource level individually. To do that we take the SUM of the average score that we calculated 

for each department. Then we divide it by the SUM of the total high score, which in this case we made 100% for each 
department. This then gave us the total score for SR and RL. 

 

6. Once the calculations were done, we created a new worksheet in excel naming it the “Table and 
Graph” section. In this worksheet we created two tables, first select how many rows and 
columns are needed, then go to the insert tab on top of the workbook and select table. 
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Figure 11   For the Complexity table it only requires one column and two rows, we followed the same copy and linking to source 

on the tables. We took Complexities average score and linked it to the table. Then we created another table with columns 
holding the department values, followed by the average score for Strategic Readiness and Resource Level by each department, 

and then the last column taking the average score between Strategic Readiness and Resource Level for each department. 

 

7. We created a PowerPoint presentation to interpret these results for customers.  See sample 
assessments results below: 

 
Figure 12 Here is an example of how we formatted the timeline to our clients’ customers, based on their complexity score. 
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Figure 13 Here is an example of how depending on the SR score can determine if it will extend the M&A/ Rebrand merger. 
Seeing as they were in the medium category, their merger may take up to an additional 3-9 months. 

 

 
Figure 14 Here is an example how the RL score can affect the company's timeline and see if it will need to be extended even 

further. In Figure 14, we can see how they have high resources levels putting them in a green zone, it may only add an additional 
1-3 months to their timeline.  
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Figure 15 displays the average scores for both SR and RL for each of their designated departments. Along with the average score 
between the SR and RL together for each department. On the right side of the figure, we have a description of what the ranges 

of scores signifies.   

 
Results & The Positive Impact 
HR Consulting Company 
On April 9, 2024, a meeting was held with the client and the HR Consulting Company, where 
discussions centered on the A industry's complexity, strategic readiness, and resource levels. 
The survey conducted revealed a comprehensive understanding of M&A impacts, notably in 
legal and brand integration aspects, with a focus on marketing and logo changes. Despite taking 
about 15 minutes to complete, the survey’s complex slides posed comprehension challenges. 
Respondents reported moderate strategic readiness, at 55%, indicating room for improvement 
in preparedness. However, there was a high level of resource availability, with 94% of 
respondents indicating very good employees and internal support. This suggests a need for 
improved communication and tools such as task hour tracking and brand decision-making aides, 
particularly for M&A. Feedback on responses varied, with the #1 Industry’s being deemed 
accurate but surface level, especially regarding logo changes. One of our group members 
emphasized the importance of HR involvement, highlighting its necessity in M&A processes. 
 
Technology Marketing Company  
On April 9, 2024, a meeting was held with the client and Technology marketing company 
focusing on discussions regarding complexity, strategic readiness, and resource levels. Feedback 
from the survey highlighted the ease of completion due to the use of survey highlighted the 
ease of completion due to the use of multiple-choice questions, with participants appreciating 
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the structured format and the ability to factor in and rank responses. Despite the survey taking 
approximately 15 minutes to complete, its complexity varied depending on the size of the 
business. Strategic readiness was reported at 65%, indicating a need for more time for decision-
making, particularly 1-3 months, and improved communication with executive teams for 
approval processes. Resource levels were rated at 82%, suggesting a high level with no need for 
additional time, spanning 16-18 months. Participants found the survey to be a useful tool for 
preparation, especially in larger companies, where the assessment tool could be utilized across 
various areas. One of our group member’s questions regarding marketing and communication 
accuracy emphasized the need for better communication, particularly if tasks are completed 
ahead of time. Also, other questions have highlighted the importance of clarifying assessments 
for larger companies, especially regarding project complexity and pricing considerations. 
Overall, participants expressed satisfaction with the survey’s structure and utility in aiding 
decision-making processes for the Technology marketing company.  
 
Construction Company 
On April 9, 2024, a meeting convened with the Construction company, delving into discussions 
regarding the intricacies of the survey about the complexity, strategic readiness, and resource 
levels. Participants voiced confusion over certain survey sections, indicating difficulty in 
comprehension and suggesting a need for clarity, particularly for smaller companies. Despite 
the challenges, strategic readiness was reported at a robust 87%, with a medium timeframe of 3 
to 9 months for implementation. Total completion complexity, influenced by both timeframe 
and high strategic readiness, was estimated at 4 to 12 months. Resource levels were also 
deemed sufficient, standing at 87%. Construction company’s response shed light on potential 
misunderstandings, especially concerning bundled topics like marketing and digital aspects, 
calling for clearer assessment versions tailored to smaller companies. Feedback suggested 
utilizing the survey as a tool, with a proposed budget of $150,00 for strategic planning 
enhancements, including the use of B and D industry, with an emphasis on building trust, 
particularly in remote settings compared to B2B interactions. Additionally, discussions with 13 
agencies were underway to aid in strategic decision-making processes. 
 
Conclusion 
Leveraging Automation for Comprehensive Survey Design in Mergers & Acquisitions 
Mergers and acquisitions require an understanding of how businesses work together, being 
prepared for strategic changes, and identifying available resources. To make useful decisions 
during a brand transition, we need to gather a significant amount of information. Surveys play a 
critical role in this task, but they can be time-consuming to quantify. By automating the survey 
process, we can get accurate and relevant information fast. The McKinsey Global Institute’s 
study found that automation has the potential to increase global productivity growth by 0.8% to 
1.4% annually (McKinsey Global Institute, 2017). Further research discusses how automation 
can help streamline these processes and provide us with quantifiable results. 
 
To optimize efficiency, it is vital to utilize automation tools like macros, functions, and advanced 
add-ins. These tools assist in simplifying survey processes, saving time, and providing accurate 
data analysis. It can contribute to an overall more efficient way for companies to collect data. 
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Macros, which are specifically useful in Excel, automate repetitive tasks like data manipulation 
and formatting. By programming macros to manage these tasks, users can conserve time and 
concentrate on more critical work. (Admin, 2017)  
 
Exploring Macros and VBA Code in Microsoft Office Applications 
A massive portion of our project's time was consumed up by repetitive data entry.  
One area where we can enhance our project is by minimizing the time spent on repetitive data 
entry tasks. Macros, also known as VBA code, is a useful tool to automate repetitive tasks in 
various Microsoft Office applications. Applications that use macros are Excel, Word, PowerPoint, 
Outlook, and Access.  Macro is the term used to describe lines of code written in VBA also 
known as Visual Basic for Applications. It runs within the application itself, without the need for 
additional software. By using Macros individuals can speed up tasks and provide greater 
precision compared to what we had done, which was manual efforts. There are two ways to 
create macros the first way is by using the Macro Recorder and the second way is by writing the 
code directly in the Visual Basic Editor. Macros are particularly useful when dealing with large 
datasets or when performing consistent analyses on different datasets. (McKay, 2024). 
 
Limitations of Macros and VBA Code in Microsoft Office Applications 
It is important to know the limitations when using Macros and VBA code in Microsoft Office 
applications. Macros and VBA Code is not able to create ActiveX Controls, integrate with Visual 
Source Safe, build executables, create ActiveX Dynamic Link Libraries, use, or integrate between 
multiple projects, reuse any Visual Basic Component, or create OLE Automation Servers. (n.d.) 
 
Streamlining Excel Tasks: Enabling Developer Tab and Recording Macros 
To simplify tasks in Excel, you can access the Developer tab by clicking on the "File" menu, 
selecting "Options," and then choosing "Customize Ribbon." In the next menu, check the box 
beside "Developer" in the list of Main Tabs. 

 
Figure 16 illustrates how to get to the Developer customization. 
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Figure 17 illustrates how to get to "Record Marco" in order to record the macros. 

 
To record a macro, switch to the Developer tab and click "Record Macro." A dialog box will 
appear, providing details such as the macro's name, optional shortcut key, and storage location. 
Then click "OK" to start recording. Excel will record every action until you stop the recording by 
returning to the Developer tab and clicking "Stop Recording." This process can assist in 
automating repetitive tasks and improve productivity. 
 
Understanding the Limitations of Excel's Macro Recorder 
The macro recorder in Excel is a wonderful tool when it comes to automation, but it has its 
limitations. It cannot create code for repeating statements, setting up variables, managing 
errors, making functions, or adding code within existing macros. It also does not consider 
individual user settings. While it is great for basic automation, you might need to write code 
yourself or change around the recorded macro to manage more complex tasks.  
 
During our project, we found ourselves spending a significant amount of time on repetitive tasks 
such as inputting client information. Macros is a great programming tool to help manage these 
tasks, help users conserve time, and concentrate on more critical work. However, utilizing 
macros can not only be beneficial for mergers and acquisitions, but also for other industries 
looking to gather client input and analyzing that input for research and development purposes. 
In conclusion, automation goes beyond just saving time and reducing manual effort; it changes 
our strategy for data management and analysis. It enables informed decision-making and 
supports the success of our merger initiatives. 
 
PREP Student Reflection 
This experiential experience has opened our eyes to the world of M&A, prior to this 
project/internship most of us did not know what went into the process of acquiring and 
merging companies together. The further into the semester we got the more we could see how 
intricate and complex the whole process is. Compared to some of our previous internships that 
we have done, this one felt way more hands on, and a lot of trial and error with establishing 
how we thought the survey and model should look and function. Overall, it was a great 
experience, and it has piqued our interest in the M&A industry, and we will make sure to hone 
the skills we learned from this internship and apply it to our future project/careers. 


